scanCONTROL 3D-View 3.4

Instruction Manual
Contents

1. Introduction ............................................................................................................. 4
   1.1 Use of the Manual ......................................................................................... 4
   1.2 Functional Scope of scanCONTROL 3D-View ........................................... 4
   1.3 Definition of Terms for Profile, Profile Sequence and Point Cloud .......... 5

2. Installation and Preparation for Measurement Operation ............................... 6
   2.1 Installation Requirements ........................................................................... 6
   2.2 Installation of the Software ....................................................................... 6
   2.3 Connecting scanCONTROL to the PC ....................................................... 6

3. Working with scanCONTROL 3D-View .............................................................. 8
   3.1 Operation Modes ....................................................................................... 8
   3.2 Starting the Software ................................................................................ 8
   3.3 Description of the Main View .................................................................... 9
   3.4 Online Mode ............................................................................................. 9
   3.4.1 Description of the “Sensor settings” and the “3D mode” Box .............. 10
   3.4.2 Description of the “Advanced Sensor settings” Dialog Box ............. 12
   3.5 Offline Mode ............................................................................................ 20
   3.5.1 Description of the “File settings” and the “3D mode” Box ................. 20
   3.6 Filtering Measurement Data .................................................................... 23
   3.7 Displaying scanCONTROL Parameters in Offline Mode ......................... 25
   3.8 Description of the “Display settings” Box ............................................... 28
   3.9 Description of the “3D data” Box ............................................................ 29
   3.10 Description of the “Lighting/Surface” Box .............................................. 30
   3.11 Visualization of the Profile Data ............................................................. 30
   3.12 Description of the Preview Window ....................................................... 31
   3.13 Description of the 2D-View .................................................................... 31
   3.14 Description of the 3D-View .................................................................... 34
   3.15 Description of the Status Display ............................................................ 35
   3.16 3D Visualization of a Point Cloud – Step by Step .................................. 36
   3.16.1 In Online Mode .................................................................................. 36
   3.16.2 In Offline Mode ................................................................................... 38
   3.17 3D-View Settings ...................................................................................... 39
   3.18 Resetting Parameters to the Default Settings ........................................ 42
   3.19 Functions of the Toolbar ........................................................................ 42
   3.20 “Display Image Data” View .................................................................... 43
   3.21 Adjusting scanCONTROL Network Settings (Ethernet Configurator) ..... 45
   3.22 Documentation and Help for scanCONTROL 3D-View ....................... 47
   3.23 Exiting scanCONTROL 3D-View ............................................................ 47

4. Extended Functions of scanCONTROL 3D-View ................................................ 48
   4.1 Loading and Saving Parameters .............................................................. 48
   4.1.1 Saving Parameters .............................................................................. 48
   4.1.2 Loading Parameters ........................................................................... 48
   4.2 Saving Profiles ......................................................................................... 48
   4.3 Exporting Images ..................................................................................... 49
   4.4 Exporting 3D Data ................................................................................... 49
   4.5 Printing ..................................................................................................... 50
   4.5.1 Print Preview ....................................................................................... 50
   4.5.2 Printing the Current View ................................................................. 50
   4.6 Selecting the Language ............................................................................ 50

5. Annex .................................................................................................................. 52
   5.1 Notes on Using scanCONTROL 3D-View .............................................. 52
   5.2 Key Shortcuts/Mouse Functions .............................................................. 53
   5.3 Status and Error Messages ....................................................................... 54
   5.4 Color Palettes ......................................................................................... 55
1. Introduction

This user manual will give you an overview of the functions of the software package scanCONTROL 3D-View.

scanCONTROL 3D-View offers you a three-dimensional visualization of point data which have been recorded with the scanCONTROL measurement system. Additionally, 3D-View provides the possibility to export and save the visualized data for later offline analysis.

The scanCONTROL measurement system acts as a basis for scanCONTROL 3D-View. scanCONTROL is a high speed sensor which is designed for applications in industrial environments. It is characterized by high measurement speed and accuracy.

3D-View supports the following scanCONTROL measurement systems:

- scanCONTROL 2500-25/2510-25
- scanCONTROL 2500-50/2510-50
- scanCONTROL 2500-100/2510-100
- scanCONTROL 2600-25/2610-25/2650-25/2660-25
- scanCONTROL 2600-50/2610-50/2650-50/2660-50
- scanCONTROL 2600-100/2610-100/2650-100/2660-100
- scanCONTROL 2700-25/2710-25/2750-25/2760-25
- scanCONTROL 2700-50/2710-50/2750-50/2760-50
- scanCONTROL 2700-100/2710-100/2750-100/2760-100
- scanCONTROL 2900-10/2910-10/2950-10/2960-10
- scanCONTROL 2900-25/2910-25/2950-25/2960-25
- scanCONTROL 2900-50/2910-50/2950-50/2960-50
- scanCONTROL 2900-100/2910-100/2950-100/2960-100
- scanCONTROL 2657-25/2657-50/2657-100
- scanCONTROL 3000-25/3010-25/3050-25/3060-25
- scanCONTROL 3000-50/3010-50/3050-50/3060-50
- gapCONTROL 2611-25/2661-25
- gapCONTROL 2611-50/2661-50
- gapCONTROL 2611-100/2661-100
- gapCONTROL 2711-25/2761-25
- gapCONTROL 2711-50/2761-50
- gapCONTROL 2711-100/2761-100
- gapCONTROL 2911-10/2961-10
- gapCONTROL 2911-25/2961-25
- gapCONTROL 2911-50/2961-50
- gapCONTROL 2911-100/2961-100

Note: In the following the term scanCONTROL stands for all measurement systems listed above.

1.1 Use of the Manual

The user manual contains all the information for the installation and application of scanCONTROL 3D-View.

As a user of the software read Chapter 2 "Installing and preparing for measurement operation". Chapter 3 "Working with scanCONTROL 3D-View" explains how the software functions are used.

Note: Please refer to the contact address printed on the inside cover for any issues relating to queries and support or any other technical information.

1.2 Functional Scope of scanCONTROL 3D-View

scanCONTROL 3D-View transfers profile data in a simple way from the scanCONTROL measurement system via Ethernet and presents it three-dimensionally. Data, which has been saved with scanCONTROL 3D-View, scanCONTROL Configuration Tools, gapCONTROL Setup Software or scanCONTROL Developer Tool, can be loaded and visualized.

scanCONTROL 3D-View offers the possibility of saving the 3D data for later offline analysis and of exporting the data in a variety of standard formats. An option for maximizing the 3D-View and a print function
are available for the detailed viewing of 3D data. The loading and saving of parameters simplifies working with different objects and settings.

The detailed functional scope of scanCONTROL 3D-View is listed below:

- Data transfer via scanCONTROL (online mode)
- Load saved profile sequence (offline mode)
- 3D visualization
- Configure scanCONTROL
- Synchronization (triggered mode)
- Filter functions
- Restore factory settings
- Maximize preview
- Maximize 2D-View
- Maximize 3D-View
- Print function
- Load and save parameters
- Load scanCONTROL parameters offline
- Save profile sequences
- Export images
- Export 3D data

1.3 Definition of Terms for Profile, Profile Sequence and Point Cloud

The terms "profile", "profile sequence" and "point cloud" are used repeatedly in this manual in the context of the software, and are defined as follows:

A "profile" consists of a maximum of 2048 individual measurement points, each of which is defined by a X coordinate and a Z coordinate (two-dimensional).

A chronologically consecutive series of profiles is called a "profile sequence". All points located in a profile sequence are also designated as a "point cloud". Each of these points is defined by its X, Y/T and Z coordinates (three-dimensional), whereby the Y/T coordinates arise from the chronological offset in the individual profiles (see Chapter 3.14).
2. Installation and Preparation for Measurement Operation

2.1 Installation Requirements

The following minimum system specification is necessary for the operation of scanCONTROL 3D-View:

- Windows 7 (64 bit), Windows 8 or 8.1 (64 bit), Windows 10 (64 bit)
- 1 GHz or faster (64 bit) processor
- 1 GB RAM
- Screen resolution: 1024 x 768
- Graphics card / GPU supporting OpenGL 3.1 or higher

To be able to use scanCONTROL 3D-View the following steps must be followed:

1. Install the Ethernet interface hardware, if not already installed.
2. Install scanCONTROL 3D-View (see Chapter 2.2).
3. Connect the scanCONTROL measurement system to the PC via Ethernet.

| CD:\Documentation | Contains manuals, installation instructions and Quick Reference |
| CD:\Examples | Contains examples of profile sequences |
| CD:\License | Contains license information for scanCONTROL 3D-View |
| CD:\Program\scanCONTROL 3D-View 3.4 | Contains scanCONTROL 3D-View 3.4 |
| CD:\Support\Adobe Reader DC | Contains Adobe Reader DC |
| CD:\Support\Ethernet | Contains a software tool for configuration of the IP addresses of scanCONTROL devices with an Ethernet interface |
| CD:\Support\FlmageFilter | Contains filter files for integrating DirectX |
| CD:\Support\Sentinel System Driver 7.5.0 | Contains the "Microsoft Visual C++ 2008" Redistributable Package |
| CD:\Support\VCRedist2008 | Contains the "Microsoft Visual C++ 2013" Redistributable Package |

Fig. 2.1: Content of the Software CD

2.2 Installation of the Software

When you insert the Software CD an installation window appears which offers you a number of options. Alternatively you can start the window with the [CD]\setup.exe file.

Click on the "Install" button to start installing the software.

Now the installation wizard installs the software and necessary components.

Note: You need administrator rights in order to install the software.

Note: Activate the "Configure windows firewall" option in order to enable the data transfer between scanCONTROL and the PC in case of an active windows firewall.

Note: If a third-party firewall is installed on your operating system, you need to include 3D-View in the firewall exception list to enable communication between the measurement system and the software.

2.3 Connecting scanCONTROL to the PC

In order to connect scanCONTROL via Ethernet to the PC, proceed as follows:

1. Finish the installation of scanCONTROL 3D-View completely. This procedure is described in Chapter 2.2.
2. Connect scanCONTROL via the Ethernet interface to the PC and switch on the power supply.
3. Please wait until the device is recognized by the PC. This may take a few seconds.

The system is now ready to operate the scanCONTROL measurement system with scanCONTROL 3D-View.
Note: scanCONTROL must be connected directly with the PC. Do not use hubs or switches.

Note: In case of using a network adapter which supports the "VLAN" option, this option must be inactive in order to use the scanCONTROL measurement system.

Note: The PC and the measurement system must be located in the same subnet in order to operate the scanCONTROL measurement system with 3D-View. Use the "Ethernet configurator" dialog box (see Chapter 3.21) in order to adjust the network settings of the measurement system, if necessary.
3. Working with scanCONTROL 3D-View

3.1 Operation Modes

Depending on the selected data source scanCONTROL 3D-View provides two different operation modes:

<table>
<thead>
<tr>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>scanCONTROL</td>
<td>The scanCONTROL measurement system acquires measurement data and transfers them to the PC. scanCONTROL 3D-View visualizes the measurement results.</td>
</tr>
<tr>
<td>(online mode)</td>
<td></td>
</tr>
<tr>
<td>File (offline mode)</td>
<td>The software plays back a saved profile sequence and visualizes the measurement results.</td>
</tr>
</tbody>
</table>

3.2 Starting the Software

Once the installation of the software is completed, you can start the software. For this, use the program link on your desktop or the start menu entry "scanCONTROL 3D-View".

After you have started the program, the main view of scanCONTROL 3D-View appears (see Fig. 3.1).

Note:
- Never disconnect the connection between scanCONTROL and the PC while using the software.
- Never disconnect the power supply of scanCONTROL while the software is running.

This may cause the software to shut down unintentionally.
3.3 Description of the Main View

Fig. 3.1: Main view

In the upper section of the main view you will find the menu bar and the toolbar (see Fig. 3.1, ①) which you can use for activating various dialog boxes of settings and views (see Chapter 3.19).

In the upper left section of the main view (see Fig. 3.1 ②), depending on the operation mode (online/offline mode), you can either change settings on the scanCONTROL measurement system, or visualize previously saved profile sequences (refer also to Chapter 3.4 or 3.5). Below the "3D mode" box there is an information field ③, in which the current system status is shown (see Chapter 5.3). In the lower left section you configure the settings for the display (refer also to Chapter 3.8). In section ④ you can change the settings for filtering the 3D data and for removing a trend (see Chapter 3.9). Section ⑤ contains the settings for the lighting and surface properties of the 3D display (see Chapter 3.10). In the right section there are the preview window ⑦ (see Chapter 3.8), the 2D-View ⑧ (see Chapter 3.13) and the 3D-View ⑨ (see Chapter 3.14).

In the lower section of the main view there is the status line (see Fig. 3.1, ⑩). Status and error messages are displayed. For a complete list of the possible messages please refer to Chapter 5.3.

3.4 Online Mode

After starting the software scanCONTROL 3D-View is in online mode. In online mode data from the scanCONTROL measurement system is transferred directly to the PC and visualized by the software.

If you are in offline mode, you can activate the online mode either by selecting the "File → Connect to sensor" menu item or by pressing the corresponding button in the toolbar (see Fig. 3.2).

Use the "Sensor settings" box to configure the measurement system.

Fig. 3.2: "Connect to sensor" button
3.4.1 Description of the "Sensor settings" and the "3D mode" Box

Use the parameters in these boxes to configure scanCONTROL for your measuring task.

**Note:** The parameters "Exposure time"/"No. of profiles" are dependent on each other. Thus with setting the parameter "No. of profiles" to 50 profiles per second the maximum value for "Exposure time" is 20 ms, for example.

**Fig. 3.3:** "Sensor settings" and "3D mode" boxes

You enter the following settings:

- **Operating mode:** With this parameter you select the operating mode of scanCONTROL.
  - **High resolution:** scanCONTROL is operated with the maximum resolution in Z direction.
  - **High speed:** scanCONTROL is operated at a frequency of up to 10 kHz (scanCONTROL 3050/3060). The resolution in Z direction is halved. The resolution in the X direction remains unchanged.
  - **High dynamic range (HDR):** scanCONTROL is operated in the High Dynamic Range (HDR) mode. The resulting profile is composed of two profiles with different exposure times.

- **Exposure time [ms]:** With this parameter you select the exposure time for the scanner.
  - Minimum value: 0.01 ms.
  - Maximum value: 40.0 ms.

- **No. of profiles [1/s]:** This parameter controls the number of profiles which are acquired per second and transferred to the PC. This value has priority over the "Exposure time" parameter.
  - Minimum value: 25.
  - Maximum value: depends on the type of sensor:
    - scanCONTROL 2500/2510/2600/2610/2900/2910/3000/3010: 300
    - scanCONTROL 2700/2710: 100
    - scanCONTROL 2650/2660/2750/2760/2657: 4000
    - scanCONTROL 2950/2960: 2000
    - scanCONTROL 3050/3060: 10000

- **Filter...:** With this button you access the "Profile filter settings" dialog box (see Chapter 3.6).

- **Advanced...:** With this button you access the "Advanced Sensor settings" dialog box (see Chapter 3.4.2).

- **Buffered profiles:** This parameter defines the number of profiles that make up a point cloud, i.e. you determine the resolution in the Y/T direction with this parameter. The minimum adjustable value is 10. The maximum adjustable value depends on the following factors:
  - RAM/Paging file
  - Operating system/Architecture
  - "Points per profile" parameter
  - "Profiles" and "Quality" parameters, located in the "Drawing method" input field (see Chapter 3.17)

- **Feed speed:** With this parameter you specify the feed speed. Depending on the operation mode of scanCONTROL, this parameter has the following unit:
  - **Trigger input inactive, encoder inactive:** mm/s
  - **Trigger input active, encoder inactive:** mm/trigger pulse
  - **Encoder active:** mm/encoder edge
With a known feed speed scanCONTROL 3D-View calculates real coordinates in the feed direction and displays them as the Y axis in the 3D-View. If the feed speed is not known, the profile indices are plotted in the feed direction and they are displayed as the T axis in the 3D-View.

- **Preview mode:** Use this parameter to select the type of data transmission.
  - **continuous:** The data is continuously transferred from scanCONTROL. The preview window is updated continuously.
  - **trigger:** Select this option to transfer a profile sequence from the scanner at a defined point in time. The scanCONTROL measurement system initially transfers no profiles. Start the data transfer with the "Trigger" button. scanCONTROL then acquires and transfers the measurement data to the PC. Once the number of profiles defined in the "Buffered profiles" entry field is reached, the transferred point cloud is visualized in the preview window and scanCONTROL stops the data transfer.

- **Color coding:** This value specifies which measurement data from scanCONTROL is used for the colored texture of the point cloud in the individual views. The selected information is evaluated for each single point in the point cloud and displayed in color. The following selections are available:
  - **Intensity:** The maximum intensity of the reflection.
  - **Z coordinate:** The Z coordinate.
  - **Width:** The width of the reflection.
  - **Threshold:** The threshold which was applied depending on the backlight in order to detect a reflection.
  - **Moment 0:** Zeroth order moment (the area of the reflection).

**Note:** The "Sensor settings" dialog box is available only in online mode!

**Note:** The elements of the “3D mode" box vary depending on the operation mode (Online/offline mode).

**Note:** For further information on the configuration of the measurement system, please refer to the instruction manual of the measurement system used and to the documents "Quick Reference scanCONTROL" and "Manual scanCONTROL (Part B)" (see Chapter 3.22).
3.4.2 Description of the "Advanced Sensor settings" Dialog Box

This dialog box offers you extended settings for the scanCONTROL measurement system.

**Note:** The parameters "Measuring field"/"Points per profile" are dependent on each other.

**Note:** Only experienced users of the scanCONTROL measurement system should change settings in this dialog box.

![Advanced sensor settings dialog box](image)

**Fig. 3.4: "General" tab sheet in the "Advanced Sensor settings" dialog box**

- **Type:** The connected measurement system and its associated firmware version are displayed.
- **SN:** The serial number of the connected measurement system is displayed.
- **IP address:** The IP address of scanCONTROL is displayed. If the manual input of the IP address is activated, you may enter the IP address here.
- **Sensor selection:** This list contains all scanCONTROL measurement systems connected to the PC. Additionally, you may activate the manual input of the IP address here. Use this selection and the Connect/Disconnect button (see below) in order to activate a desired measurement system.
- **Connect/Disconnect:** Depending on the selection of the scanner list this button behaves as follows:
  - **Disconnect:** If the currently active measurement system is selected in the scanner selection, you may disconnect the measurement system using the "Disconnect" button.
  - **Connect:** If a measurement system is selected which isn't currently connected to 3D-View, you may use the "Connect" button in order to connect to the selected measuring system. In doing so, the previously connected measurement system gets disconnected.
- **Find...:** Press this button in order to identify all scanCONTROL measurement systems which are connected to the PC. This function is performed automatically with starting the software. After completing this procedure the scanner selection list will be refreshed and you may change between the individual measurement systems.
- **Points per profile**: This parameter defines the number of points that make up a profile. Depending on the type of sensor you can choose between the following values:
  - **scanCONTROL 25X0**:
    - 160
    - 320
    - 640
    - max (640): The maximum number of points per profile, which is provided by the measurement system used
  - **scanCONTROL 26X0/27X0**:
    - 80
    - 160
    - 320
    - 640
    - max (640): The maximum number of points per profile, which is provided by the measurement system used
  - **scanCONTROL 29X0**:
    - 160
    - 320
    - 640
    - 1280
    - max (1280): The maximum number of points per profile, which is provided by the measurement system used
  - **scanCONTROL 30X0**:
    - 256
    - 512
    - 1024
    - 2048
    - max (2048): The maximum number of points per profile, which is provided by the measurement system used

With this parameter you specify the resolution in the direction of the X axis. The number of points is also influenced by the "Measuring field" parameter!

- **Invert in X direction**: The signal is inverted on the Z axis.
- **Invert in Z direction**: The signal is inverted in the middle of the measurement range parallel to the X axis. This parameter is enabled in the default settings.

- **Threshold**: This value specifies the value of intensity at which the scanner recognizes a reflection.  
  - **absolute**: The chosen threshold (0-1023) is used as absolute threshold.
  - **dynamic**: The chosen threshold (0-1023) is used as a percentage of the maximum intensity of a reflection (value[\%] = 100*threshold/1024). If you want to use a threshold which corresponds to 25 % of the maximum intensity, for example, you have to set the threshold parameter to 256.

- **Reflections**: With this parameter you determine which reflection is detected as a profile point. This parameter is only important for multiple reflections.  
  - **first**: The reflection closest to the scanner.
  - **last**: The reflection furthest away from the scanner.
  - **largest area**: The reflection with the largest area. This setting is enabled in the default settings.
  - **highest intensity**: The reflection with the highest intensity.
  - **only single**: The reflection is processed only if there is only a single reflection for this profile point.

- **Laser power**: You can operate the laser of scanCONTROL at two different power levels or switch it off. Depending on the type of sensor the following options are available:
  - **scanCONTROL 25X0/26X0/29X0/30X0**:
    - **off**: Laser is switched off.
    - **reduced**: reduced power level.
    - **standard**: standard power level.
    - **reduced (pulsed)**: pulsating with reduced power level. This option is used to synchronize two scanCONTROL measurement systems with alternately pulsed lasers. The "RS422 mode" parameter must be set to "ext. trigger input" or "ext. trigger output".
- **standard (pulsed):** pulsating with standard power level. This option is used to synchronize two scanCONTROL measurement systems with alternately pulsed lasers. The "RS422 mode" parameter must be set to "ext. trigger input" or "ext. trigger output".

- **scanCONTROL 27X0:**
  - **off:** Laser is switched off.
  - **reduced:** reduced power level.
  - **standard:** standard power level.

- **Auto exposure:** Use these parameters to configure the automatic exposure time control.
  - **Active:** Select this input field to activate the automatic exposure time control of the scanCONTROL measurement system. This setting is recommended for scanning single-colored, alternating surfaces.
  - **Shutter alignment:** With this parameter you determine how the specified scan rate is maintained with active automatic exposure time control.
    - **center:** The intervals are in each case aligned to the center of the interval.
    - **right:** The intervals are in each case aligned to the end of the interval.
    - **left:** The intervals are in each case aligned to the start of the interval.
    - **none:** The intervals are not aligned.
  - **Mode:** Use this parameter to specify the algorithm for the automatic exposure time control.
    - **raw data:** The automatic exposure time control is computed based on the raw data (Sensor matrix).
    - **profile:** The automatic exposure time control is computed based on the profile data.
    - **filtered profile:** The automatic exposure time control is computed based on the filtered profile data.
  - **Minimum [ms]:** The minimum exposure time used for the automatic exposure time control.
  - **Maximum [ms]:** The maximum exposure time used for the automatic exposure time control.

- **Min. width:** Minimum width of a reflection to be detected as a valid profile point.
- **Max. width:** Maximum width of a reflection to be detected as a valid profile point.
- **Min. intensity:** Minimum intensity of a reflection to be detected as a valid profile point.
- **Max. intensity:** Maximum intensity of a reflection to be detected as a valid profile point.

**Note:** The "Auto exposure - Minimum" and "Auto exposure - Maximum" parameters are only available when using a scanCONTROL 30X0 measurement system.

**Note:** The available options for the "Auto exposure" parameter vary depending on the sensor type.
Fig. 3.5: "Measuring field" tab sheet in the "Advanced Sensor settings" dialog box

- **Measuring field**: Activate the measuring field of scanCONTROL. The measuring field is defined by the percentage of the start and end positions.
  - **Start column [%]**: The first column of the measuring field.
  - **End column [%]**: The last column of the measuring field.
  - **Start row [%]**: The first row of the measuring field.
  - **End row [%]**: The last row of the measuring field.

- **Measuring field 2**: Activate the second measuring field of scanCONTROL. The measuring field is defined by the percentage of the start and end positions.
  - **Start column [%]**: The first column of the second measuring field.
  - **End column [%]**: The last column of the second measuring field.
  - **Start row [%]**: The first row of the second measuring field.
  - **End row [%]**: The last row of the second measuring field.

- **Region of no interest**: Activate the measuring field of scanCONTROL, in which the profile points are not evaluated ("Region of no interest"). The measuring field is defined by the percentage of the start and end positions.
  - **Start column [%]**: The first column of the "Region of no interest".
  - **End column [%]**: The last column of the "Region of no interest".
  - **Start row [%]**: The first row of the "Region of no interest".
  - **End row [%]**: The last row of the "Region of no interest".

- **Reference field for auto exposure**: Activate the reference field of scanCONTROL, from which the profile points for the automatic exposure time are used. The measuring field is defined by the percentage of the start and end positions.
  - **Start column [%]**: The first column of the reference field.
  - **End column [%]**: The last column of the reference field.
  - **Start row [%]**: The first row of the reference field.
  - **End row [%]**: The last row of the reference field.

Profile points which are located in the "Measurement field" or in the "Measuring field 2" and not in the "Region of no interest" will be evaluated.

**Note**: The "Measuring field 2", "Region of no interest" and "Reference field for auto exposure" are only available when using a scanCONTROL 30X0.
Note: The "Start/End column" parameters must be a multiple of the following factors, depending on the type of sensor: scanCONTROL 26X0/27X0: 1,25%; scanCONTROL 25X0/29X0: 2,5%; scanCONTROL 30X0: 1,5625%.

Fig. 3.6: "Interface" tab sheet in the "Advanced Sensor settings" dialog box

- **RS422 mode**: Use this parameter to configure the function of the RS422 interface of scanCONTROL. Depending on the type of sensor you can choose between the following values:
  - **scanCONTROL 25X0/26X0/29X0/30X0**
    - serial: The RS422 interface is used as serial port. Commands are received.
    - ext. trigger input: The RS422 interface is used as synchronization and trigger input (see below, parameter "Trigger mode").
    - ext. trigger output: The RS422 interface is used as synchronization and trigger output.
    - CMM trigger: Activate this setting in order to use the RS422 interface as programmable trigger output (see below, parameter "Enable CMM trigger").
  - **scanCONTROL 27X0**
    - automatic: scanCONTROL configures the function of the RS422 interface automatically.
    - serial: The RS422 interface is used as serial port. Commands are received.
    - external trigger: The RS422 interface is used to synchronize and trigger the scanCONTROL measurement system (see below, parameter "Trigger mode").
    - CMM trigger: Activate this setting in order to use the RS422 interface as programmable trigger output (see below, parameter "Enable CMM trigger").
    - encoder/counter: Activate this function in order to access the internal counter of scanCONTROL via the RS422 interface (see below, input field "Counter (Encoder)").
    - pulsed laser: The RS422 interface is used to synchronize two scanCONTROL measurement systems. The lasers are alternately pulsed.
- **Serial baudrate:** Use this parameter to specify the baudrate at which the serial port operates. This parameter is only active in case of using the "serial" value for the "RS422" parameter.
  - 9600
  - 19200
  - 38400
  - 57600
  - 115200
- **No RS422 termination:** Disables the termination resistor of the RS422 circuit. When deactivating this parameter, the default termination is used (serial: Termination active; ext. trigger input: Termination active; ext. trigger output: Termination inactive; CMM trigger: Termination inactive).
- **Digital input mode:** Use this parameter to configure the function of the digital inputs of scanCONTROL.
  - scanCONTROL 25X0/26X0/29X0
    - **encoder + reset:** Inputs 2 (A) and 3 (B) are used to access the internal counter of scanCONTROL. Input 1 (index N) is used to reset the counter.
    - **encoder + trigger:** Inputs 2 (A) and 3 (B) are used to access the internal counter of scanCONTROL. Input 1 is used as trigger input.
    - **trigger:** Input 1 is used as trigger input.
    - **user modes + trigger:** Input 1 is used as trigger input. Inputs 2 (bit 0) and 3 (bit 1) are used to load user modes.
    - **user modes:** Inputs 1 (bit 0), 2 (bit 1) and 3 (bit 2) are used to load user modes.
    - **timestamp:** The state of the digital inputs is included in the timestamp of the profiles.
  - scanCONTROL 30X0
    - **encoder + reset:** Inputs 2 (A) and 3 (B) are used to access the internal counter of scanCONTROL. Input 4 (index N) is used to reset the counter.
    - **encoder + trigger:** Inputs 2 (A) and 3 (B) are used to access the internal counter of scanCONTROL. Input 4 (index N) is used to reset the counter. Input 1 is used as trigger input.
    - **trigger:** Input 1 is used as trigger input. The state of the digital input 2, 3 and 4 is included in the timestamp of the profiles.
    - **user modes + trigger:** Input 1 is used as trigger input. Inputs 2 (bit 0), 3 (bit 1) and 4 (bit 2) are used to load user modes.
    - **user modes:** Inputs 1 (bit 0), 2 (bit 1), 3 (bit 2) and 4 (bit 3) are used to load user modes.
    - **timestamp:** The state of the digital inputs is included in the timestamp of the profiles.
    - **gated encoder:** On applying a logical "1" signal to the input 1 scanCONTROL is triggered using the encoder input. Inputs 2 (A) and 3 (B) are used to access the internal counter of scanCONTROL. Input 4 (index N) is used to reset the counter.
    - **trig. + user m. + timest.:** Input 1 is used as trigger input. Inputs 2 (bit 0) and 3 (bit 1) are used to load user modes. The state of the digital input 4 is included in the timestamp of the profiles.
    - **user m. (3) + timest. (1):** Inputs 1 (bit 0), 2 (bit 1) and 3 (bit 2) are used to load user modes. The state of the digital input 4 is included in the timestamp of the profiles.
    - **user m. (2) + timest. (2):** Inputs 1 (bit 0) and 2 (bit 1) are used to load user modes. The state of the digital input 3 and 4 is included in the timestamp of the profiles.
- **Digital input logic:** Defines the logic of the digital inputs:
  - **low level logic (5V):** TTL
  - **high level logic (24V):** HTL
- **Digital input resistor:** Define the resistor of the digital inputs:
  - **pull-up:** Pull-up resistor.
  - **pull-down:** Pull-down resistor.
- **Trigger mode**: This function enables you to control the scanCONTROL measurement system via the RS422 interface (scanCONTROL 25X0/26X0/27X0/29X0/30X0) and via the digital inputs (scanCONTROL 25X0/26X0/29X0/30X0) respectively.
  - **internal**: scanCONTROL transfers continuously according to the setting "No. of profiles [1/s]"
  
  Please use the following trigger settings only when you control scanCONTROL externally:
  - **pos. edge**: scanCONTROL is triggered with positive edges whereas the exposure time corresponds to the parameter "Exposure time".
  - **neg. edge**: scanCONTROL is triggered with negative edges whereas the exposure time corresponds to the parameter "Exposure time".
  - **pos. pulse**: scanCONTROL is triggered with positive edges whereas the exposure time corresponds to the length of the positive trigger-pulse.
  - **neg. pulse**: scanCONTROL is triggered with negative edges whereas the exposure corresponds to the length of the negative trigger-pulse.
  - **pos. gate**: On applying a logical "1" signal to the trigger input scanCONTROL transfers continuously according to the setting "No. of profiles [1/s]". When applying a logical "0" signal to the trigger input no profiles are transferred.
  - **neg. gate**: On applying a logical "0" signal to the trigger input scanCONTROL transfers continuously according to the setting "No. of profiles [1/s]". When applying a logical "1" signal to the trigger input no profiles are transferred.
  - **encoder**: scanCONTROL is triggered using the internal counter (encoder). A measurement operation is triggered after N encoder steps (N is defined by the "Encoder step" parameter, see below).

**Note**: The maximum frequency available for triggering corresponds to the "No. of profiles [1/s]" parameter.

**Note**: More information about the trigger function of scanCONTROL can be found in the instruction manual of the measurement system used.

- **Trigger source**: Select the type of inputs used for synchronization and triggering:
  - **RS422**
  - **digital inputs**

- **Encoder step**: Specifies the number of encoder steps being necessary to trigger a measurement operation. This parameter is only available if the "Trigger mode" parameter is set to "encoder".

- **Encoder active**: Use these parameters to activate the internal counter of scanCONTROL. It is possible to increment and decrement the counter.

**Note**: The "No RS422 termination", "Digital input mode", "Digital input logic" and "Trigger source" parameters are only available when using a scanCONTROL 25X0, 26X0, 29X0 and 30X0 measurement system.

**Note**: The "gated encoder", "trig. + user m. + timest.", "user m. (3) + timest. (1)" and "user m. (2) + timest. (2)" options of the "Digital input mode" parameter are only available when using a scanCONTROL 30X0.
Fig. 3.7: "Advanced" tab sheet in the "Advanced Sensor settings" dialog box

- **Suppress backlight**: Activate the automatic backlight compensation with this entry.
- **Video filter**: Activate this parameter to improve the image quality.
- **High resolution**: With this parameter you activate the subpixel resolution for the Z values.
- **Calibration**: Use this parameter to activate the calibration.
- **Packet delay [µs]**: Specifies the delay time of transferred data packets via Ethernet. This parameter is of importance in case of synchronizing multiple sensors in one subnet.
- **Enable CMM trigger**: Select this box to activate the programmable trigger output of scanCONTROL.
- **Invert trigger output**: Invert the trigger output with this parameter.
- **Trigger output**: The port at which the trigger signal is issued.
  - **Port 1**
  - **Port 2**
  - **Port 3**
  - **Port 4**
- **Trigger divisor**: This gives the division ratio between the trigger signals and the profiles. Select a value "n" to issue one trigger signal for every nth profile.
  - **Min**: 1
  - **Max**: 255
- **Mark-space ratio**: This gives the mark-space ratio for the decreasing edge.
  - **1:4**
  - **1:3**
  - **1:2**
  - **1:1**
- **Skew correction [µs]**: This parameter provides a time correction of the trigger signal in increments of 0.5 µs.
  - **Minimum**: -256.0 µs
  - **Maximum**: 255.5 µs

**Note**: The "CMM trigger" settings are not available when using a scanCONTROL 25X0 measurement system.

- **Measuring field [1/s]**: The maximum profile frequency resulting from the setting of the "Measuring field" parameter.
- **Exposure time [1/s]**: The maximum profile frequency resulting from the setting of the "Exposure time" parameter.
- **Sensor [1/s]**: The maximum profile frequency resulting from the sensor hardware.
- **Points per profile [1/s]**: The maximum profile frequency resulting from the setting of the "Points per profile" parameter (scanCONTROL 30X0).

**Note:** Further information about the listed measurement system parameters can be found in the documents Quick Reference scanCONTROL and the scanCONTROL manual (Part B) (see Chapter 3.22).

Confirm your settings with the "OK" button.

### 3.5 Offline Mode

scanCONTROL 3D-View enables you to load and visualize previously saved profile sequences. In offline mode the "Sensor settings" box is replaced by the "File settings" box.

In order to load and display profiles from a file offline, either select the "File → Open profiles" menu item or press the corresponding button (see Fig. 3.8) in the toolbar.

**Fig. 3.8: "Open profiles" button**

A standard Windows dialog is displayed where you select the path and file name. The profile sequence is loaded after confirmation of the dialog. The loaded profiles are shown in the preview window. The preview window is updated continuously.

**Note:** Use the "Recent profiles" menu item to load and display previously saved or loaded profile sequences (see Fig. 4.3).

#### 3.5.1 Description of the "File settings" and the "3D mode" Box

Use the parameters in these boxes to visualize saved profile sequences in offline mode.

**Fig. 3.9: Settings in offline mode**

In the upper section of the box the following information of the loaded profile sequence is displayed:

- **Name**: Name of the profile sequence.
- **Buffered profiles**: The number of loaded profiles.

**Note:** The following software packages save the measurement system parameters:
- scanCONTROL 3D-View
- scanCONTROL Configuration Tools
- gapCONTROL Setup Software
- DeveloperDemo (from Version 2.0, option must be activated).
- scanCONTROL Developer Tool
The following settings are available:

- **Play**: This starts the playback of the previously loaded profile sequence. The loaded profiles are shown in the preview window. The preview window is updated continuously.
- **Stop**: This stops the playback of the profile sequence. The loaded profiles are shown in the preview window and the 2D-View.
- **Info**: You press this button to display the scanCONTROL settings selected when the profile sequence was saved (see Chapter 3.7).
- **Invert signal in X**: The signal is inverted on the Z axis. You must repeat playing back the profile sequence for the parameter to take effect.
- **Invert signal in Z**: The signal is inverted in the middle of the measurement range parallel to the X axis. You must repeat playing back the profile sequence for the parameter to take effect.
- **Filter…**: With this button you access the "Profile filter settings" dialog box (see Chapter 3.6).
- **Feed speed**: With this parameter you specify the feed speed. Depending on the operation mode of scanCONTROL, this parameter has the following unit:
  - **Trigger input inactive, encoder inactive**: mm/s
  - **Trigger input active, encoder inactive**: mm/trigger pulse
  - **Encoder active**: mm/encoder edge

With a known feed speed scanCONTROL 3D-View calculates real coordinates in the feed direction and displays them as the Y axis in the 3D-View. If the feed speed is not known, the profile indices are plotted in the feed direction and they are displayed as the T axis in the 3D-View.

- **Color coding**: This value specifies which part of the measurement data of the profile sequence is used for the colored texture of the point cloud in the individual views. The selected information is evaluated for each single point in the point cloud and displayed in color. The following selections are available:
  - **Intensity**: The maximum intensity of the reflection.
  - **Z coordinate**: The Z coordinate of the point.
  - **Width**: The width of the reflection.
  - **Threshold**: The threshold which was applied depending on the backlight in order to detect a reflection.
  - **Moment 0**: Zeroth order moment (the area of the reflection).

**Note**: The availability of the individual options depends on the settings used while saving the profile sequence.

**Note**: Further information about the possible selections can be found in the documents Quick Reference scanCONTROL and the scanCONTROL manual (Part B) (see Chapter 3.22).

- **No. of profiles [1/s]**: Here you specify the scan rate used for recording the profile sequence. If the parameters were recorded in the profile sequence ("Loop back parameters" active), the scan rate is automatically updated during the replay and the field is deactivated.
- **Ignore encoder**: If the profile sequence has been saved with an active encoder input, you may use this parameter to disable the evaluation of the encoder for displaying the 3D data (see Chapter 3.14).

**Note**: The parameter "No. of profiles [1/s]" only has an effect when a measurement system feed speed is specified for the 3D-View.

**Note**: Profile sequences are stored as "avi" files. You can only play back "avi" files recorded with the following programs:

- scanCONTROL 3D-View
- scanCONTROL Configuration Tools
- gapCONTROL Setup Software
- DeveloperDemo from Version 2.0.
- scanCONTROL Developer Tool
Note: The "File settings" box is only available in offline mode!

Note: The elements of the "3D mode" box vary depending on the operation mode (Online/Offline mode).
3.6 Filtering Measurement Data

In combination with the scanCONTROL measurement system, scanCONTROL 3D-View offers you the possibility of equidistantly resampling the profile data in the X direction and of filtering it before the transfer. Invalid points are linearly interpolated during the resampling using valid points. If you want to use the filter functions, it is recommended to activate the equidistantly resampling.

You access the "Profile filter settings" dialog box via the "Filter..." button in the "Sensor settings" box (see Fig. 3.3).

Fig. 3.10: "Profile filter settings" dialog box

The following input options are available:

- **Range**: The range which is equidistantly resampled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Resampled range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>29x0-10</td>
</tr>
<tr>
<td>none</td>
<td>deactivated</td>
</tr>
<tr>
<td>tiny</td>
<td>±0.4 mm</td>
</tr>
<tr>
<td>very small</td>
<td>±0.5 mm</td>
</tr>
<tr>
<td>small</td>
<td>±1.0 mm</td>
</tr>
<tr>
<td>medium</td>
<td>±2.0 mm</td>
</tr>
<tr>
<td>large</td>
<td>±4.0 mm</td>
</tr>
<tr>
<td>very large</td>
<td>±5.0 mm</td>
</tr>
<tr>
<td>maximum</td>
<td>±10.0 mm</td>
</tr>
</tbody>
</table>

- **Interpolate invalid points**: If equidistantly resampling is active, this specifies whether invalid points will be replaced by neighbouring valid points using linear interpolation. Gaps will be closed if this parameter is active. In order to leave gaps open you must not activate this parameter.

- **Resample all info**: If equidistantly resampling is active, this parameter specifies which data will be recalculated according to the equidistantly resampling. Deactivate this parameter to recalculate the X and Z coordinates only. Activate this parameter to recalculate all data (X / Z coordinates, width, intensity, threshold, moment 0th order).

- **Median**: Activate a median filter with this parameter. Each point is respectively calculated from the median of the adjacent points.
  - **none**: The median filter is not applied.
  - **3 taps**: You use a median filter with a filter size of three.
  - **5 taps**: You use a median filter with a filter size of five.
  - **7 taps**: You use a median filter with a filter size of seven.
- **Average**: Activate an average filter with this parameter. Each point is respectively calculated from the average of the adjacent points.
  - **none**: The average filter is not applied.
  - **3 taps**: You use an average filter with a filter size of three.
  - **5 taps**: You use an average filter with a filter size of five.
  - **7 taps**: You use an average filter with a filter size of seven.

Confirm your settings with the button “OK”.

**Note**: After changing the filter settings you must transfer the profile sequence from the preview window to the 2D-View and then to the 3D-View in order to assume the changes in the 3D-View.

**Note**: When using a file as data source (see Chapter 3.5), the filter functions are only available if the filter and resampling functions have been disabled during saving the profile sequence.
3.7 Displaying scanCONTROL Parameters in Offline Mode

When playing back saved profile sequences, you have the possibility of displaying the scanCONTROL settings used while saving the profile sequence.

Press the "Info" button in the "File settings" box (see Fig. 3.9). You then access the "Sensor settings offline" dialog box.

**Note:** The following software packages save the scanCONTROL parameters:
- scanCONTROL 3D-View
- scanCONTROL Configuration Tools
- scanCONTROL Setup Software
- DeveloperDemo (from Version 2.0, option must be activated)
- scanCONTROL Developer Tool

In the dialog box you can choose between the following tabs:

- **Sensor:** The "Exposure time" and "Number of profiles [1/s]" settings used while saving the profile sequence are displayed. You will find a precise description of the individual parameters in Chapter 3.4.1. Additionally the following information is displayed:
  - **Name:** Name of the profile sequence.
  - **Path:** The path of the file.
  - **Type:** The type of the measurement system used for recording the profile sequence.
  - **SN:** The serial number of the measurement system used for recording the profile sequence.
  - **File format:** This indicates which information is contained in the saved profile sequence.
    - **x/z only:** The X and Z coordinates of the individual measurement points have been saved.
    - **x/z + data:** A complete reflection has been saved in the profile sequence. A reflection contains the following information for each measurement point: X/Z coordinates, width, intensity, threshold and moment of 0th order.
    - **x/z + [texture]:** The X and Z coordinates of the individual measurement points, their colored textures (e.g. "intensity") and the parameters used while saving the profile sequence have been saved.
    - **full set:** All four reflections, the time stamp and, where applicable, the measurement system parameters used while saving the profile sequence have been saved.
  - **Changed:** The modification date of the profile sequence.
  - **Buffered profiles:** The number of loaded profiles.

![Fig. 3.11: Sensor settings in offline mode](image)
**General:** The general settings of scanCONTROL are displayed. You will find a precise description of the individual parameters in Chapter 3.4.2.

![General sensor settings in offline mode](image)

**Measuring field:** Measuring field settings of scanCONTROL are displayed. You will find a detailed description of the individual parameters in Chapter 3.4.2.

![Measuring field settings in offline mode](image)
Interface: The interface settings of scanCONTROL are displayed. You will find a precise description of the individual parameters in Chapter 3.4.2.

Fig. 3.14: Interface settings of scanCONTROL in offline mode

Advanced: The extended settings of scanCONTROL are displayed. You will find a precise description of the individual parameters in Chapter 3.4.2.

Fig. 3.15: Extended sensor settings in offline mode
Filter: The filter settings of scanCONTROL are displayed. You will find a precise description of the individual parameters in Chapter 3.6.

Fig. 3.16: Filter settings in offline mode

3.8 Description of the "Display settings" Box

The parameters in this box have an effect on the representation in the 2D- and 3D-Views.

Fig. 3.17: "Display settings" box

You can make the following settings:

- Color scaling (2D/3D-View): With these parameters you configure the color scaling in the 2D- and 3D-Views.
  - Auto: The scaling adapts to the smallest and largest color value of the point cloud automatically.
  - Min/Max: Use this parameter for manual color scaling. The unit of the entry fields depends on the selected color scaling:
    - Intensity (0 - 1023): Gray scale values
    - Z coordinate (45 - 615): mm
    - Width (0 - 1024): internal units
    - Threshold (0 - 1023): Gray scale values
    - Moment 0 (0 - 2^18): internal units
- Z scaling (3D-View): With these parameters you configure the scaling of the Z axis in the 3D-View. Your entries in the fields "Min:" and "Max:" are specifications in mm.
  - Auto: The scaling adapts automatically to the smallest and largest Z value of the point cloud.
  - Min/Max: You use these parameters for manual scaling of the Z axis.
- Keep aspect ratio: With this parameter you determine the type of scaling for the 3D-View.
  - Active: The display is scaled so that the real aspect ratio of the displayed object is retained. If the feed speed of the sensor is known (see Chapter 3.17), the aspect ratio is retained for all three axes. If the feed speed is not known, only the aspect ratio for the X and Z coordinates is retained.
  - Inactive: The scaling adapts itself separately for each axis to the smallest and largest value on the axis.
Note: The "Display settings" box is available in both online mode and offline mode!

3.9 Description of the "3D data" Box

scanCONTROL 3D-View allows you to filter the profile data and remove a trend. The parameters in this box have an effect on the representation in the 2D- and 3D-Views.

![3D data filter settings dialog box](image)

**Fig. 3.18: "3D data" box**

After pressing the "3D data filter..." button (see Fig. 3.18), the "3D data filter settings" dialog box appears (see Fig. 3.19).

**Fig. 3.19: "3D data filter settings" dialog box**

You can make the following settings:

- **Erosion**: Activate an erosion of 2D/3D data with this parameter.
  - off: The data is not eroded.
  - 3x3: The data is eroded with a 3x3 pixel square structure mask.
  - 5x5: The data is eroded with a 5x5 pixel square structure mask.
  - 7x7: The data is eroded with a 7x7 pixel square structure mask.

- **Median**: Activate a median filter with this parameter. The points are each calculated by the median of the neighboring points.
  - off: The median filter is not used.
  - 3x3: You use a median filter with a filter size of 3x3 pixels.

- **Average**: Activate an average filter with this parameter. The points are each calculated by the mean of the neighboring points.
  - off: The average filter is not used.
  - 3x3: You use an average filter with a filter size of 3x3 pixels.
  - 5x5: You use an average filter with a filter size of 5x5 pixels.
  - 7x7: You use an average filter with a filter size of 7x7 pixels.

To determine a trend, a polynomial is fitted to the surface using an approximation method. Subsequently, the fitted polynomial is subtracted from the surface. You can make the following settings:

- **Remove trend**: Use this parameter to configure the shape of the trend.
  - none: No trend is fitted.
  - plane: A trend is fitted in the form of a plane.
  - custom...: Specify the degree of the trend polynomial:
    - **Trend degree x**: The degree of the trend polynomial in X direction (points).
    - **Trend degree y**: The degree of the trend polynomial in Y direction (profiles).
Working with scanCONTROL 3D-View

- **Included data**: Define which data should be considered for removing the trend:
  - **z + colors**: The fitted trend is subtracted from the 3D coordinates and the color values.
  - **colors**: The fitted trend is only subtracted from the color values.

**Note**: The input element "Included data" is only available if the "Color coding" parameter is set to "Z coordinate" (see Chapters 3.4.1 and 3.5.1).

**Note**: The "3D data" box is available in both online mode and offline mode!

### 3.10 Description of the "Lighting/Surface" Box

Parameterize the properties of the lighting and the surface of the 3D data in this input field. You can optimize the appearance of the 3D data with these settings in order to view details of the surface better, such as small defects. The lighting effects are most effectively when selecting the drawing method "triangles" (Parameter "Profiles") and when using a single surface color in the "3D-View settings" dialog (see Chapter 3.17).

Fig. 3.20: "Lighting/Surface" box

You can make the following settings:

- **Light source position**: Use the blue knob to adjust the position of the light source directly with the mouse. Alternatively, you can use the input fields to set the position in degrees (+/-90°). Use the input field on the right to set the distance of the light source.
- **Ambience [%] (0 - 100)**: Change the intensity of the ambient light in the 3D-View.
- **Diffuse [%] (0 - 100)**: With this parameter you can change the proportion of the diffuse reflected light from the surface.
- **Specular [%] (0 - 30)**: With this parameter you can change the proportion of the direct reflected light from the surface.
- **Shininess (0 - 100)**: Change the shininess of the surface in the 3D-View.

**Note**: The "Lighting/Surface" box is available in both online mode and offline mode!

### 3.11 Visualization of the Profile Data

In the lower left section of the program window there are two buttons for controlling the display of the profile data (see Fig. 3.1).

Fig. 3.21: "Preview → 2D-View" and "2D-View → 3D-View" button (online)

Fig. 3.22: "2D-View → 3D-View" button (offline)
Use the "Preview → 2D-View" button (see Fig. 3.21) in order to transfer the point cloud shown in the preview window into the 2D-View. Use the "2D-View → 3D-View" button (see Fig. 3.21 and Fig. 3.22) in order to transfer the region of the point cloud marked in the 2D-View into the 3D-View.

3.12 Description of the Preview Window

The preview window visualizes the last transferred profile sequence of the measurement system. scanCONTROL continuously buffers profiles according to the number specified in the "Buffered profiles" entry field and transfers these as a profile sequence to the PC. The preview window is updated after receiving the profile sequence. The vertical axis corresponds to the index of the single points in X direction. The horizontal axis represents the single profiles (chronological sequence). The gray scale value texture of the display depends on the value selected in the "Color coding" entry field.

![Preview window](image)

*Fig. 3.23: Preview window*

Depending on the setting of the entry field "Preview mode", the preview window shows the following behavior:

- **continuous**: The measurement system continuously receives data and respectively transfers the buffered profile sequence. The preview window is updated continuously.
- **trigger**: The measurement system is in the "Ready" status and doesn't transfer any data yet. You start the measurement recording with the "Trigger" button. The measurement system then acquires the specified number of profiles, transfers them to the PC and changes back to the "Ready" status. The preview window visualizes the received data.

scanCONTROL 3D-View offers the possibility to maximize the preview window. Press the button "Maximize Preview" or "Restore Preview".

![Maximize/Restore Preview button](image)

*Fig. 3.24: "Maximize/Restore Preview" button*

To transfer the point cloud shown in the preview window into the 2D-View, you double click with the middle mouse button or with the mouse wheel on the preview window or you press the button "Preview → 2D-View" or you press <F9>.

3.13 Description of the 2D-View

The 2D-View visualizes the last profile sequence transferred from the preview window. The vertical axis corresponds to the index of the points in X direction. The horizontal axis represents the individual profiles (chronological sequence). The colored texture of the display depends on the value selected in the "Color coding" entry field.
The 2D-View offers the following interaction options:

- **Zooming in/out the range**: Enable the "Zoom" mode by pressing the "Zoom" button (see Fig. 3.26). Press the left mouse button and keep it pressed to draw out a range. The 2D-View then completely visualizes the marked range when you release the mouse button. You can mark a range as often as required and zoom in the marked range. You use this function to display certain ranges with particular detail. Alternatively, you can use the mouse wheel to zoom in and out.

  ![Fig. 3.26: "Zoom" button](image)

  **Fig. 3.26: "Zoom" button**

- **Moving of the range**: Enable the "Move" mode by pressing the "Move" button (see Fig. 3.28). Press the left mouse button and move the range. Release the mouse button.

  ![Fig. 3.28: "Move" button](image)

- **Display extended information of a profile point**: Press the correspondent button (see Fig. 3.29) to activate or deactivate the "Pipette" mode. Press the left mouse button on the desired profile point. The information for the point will now be displayed in a tooltip next to the mouse pointer.

  ![Fig. 3.29: "Pipette" button](image)
Working with scanCONTROL 3D-View

- **Profile mode**: scanCONTROL 3D-View offers the possibility to display the height information along the X and Y/T axis at a defined point as profile section (see Fig. 3.30). Press the button "Pipette + Profile" (see Fig. 3.31) in order to activate the profile mode. Press the left mouse button on the desired profile point. The information for the point will now be displayed in a tooltip next to the mouse pointer and the profile section will be displayed under and accordingly next to the respective axis.

![Fig. 3.30: "Profile mode" view](image)

![Fig. 3.31: "Pipette + Profile" button](image)

To compare the profile evaluation along the X and Y/T axis, press the button "Keep z scaling for row and column data" (see Fig. 3.32). Activating this option both profile views are scaled equally in z direction. Deactivating this option the scaling is adapted separately in both profile views to the actual values in z direction.

![Fig. 3.32: "Keep z scaling for row and column data" button](image)

- **Specify the range for cutting out**: By using the "Set region of interest" button (see Fig. 3.33) you define a rectangular range in the 2D-display. Profile points which are inside the range will be displayed in the 3D-View. In addition to mouse interaction, you also have the possibility to manually edit the values for the selection area. To do this, press the right mouse button in the 2D-View. A dialog will appear in which you can make the settings.

![Fig. 3.33: "Set region of interest" button](image)

- **Remove the range for cutting out**: By using the "Reset region of interest" button (see Fig. 3.34) you will remove the range for cutting out and thus all points will be displayed in the 3D-View.

![Fig. 3.34: "Reset region of interest" button](image)

- **Maximize 2D-View**: scanCONTROL 3D-View offers the possibility to maximize the 2D-View. Press the button "Maximize 2D-View" or "Restore 2D-View" (see Fig. 3.35).

![Fig. 3.35: "Maximize/Restore 2D-View" button](image)

To transfer the point cloud shown in the 2D-View window into the 3D-View, you double click with the middle mouse button or with the mouse wheel on the 2D-View window or you press the button "2D-View → 3D-View" or you press <F10>.
3.14 Description of the 3D-View

The 3D-View visualizes the last profile sequence transferred from the 2D-View. The point cloud is displayed in an X/Y/Z or in an X/T/Z coordinate system, depending on the setting of the parameter "Enable feed speed" (see Chapter 3.17). The following units are used for the Y/T axis, depending on this setting:

<table>
<thead>
<tr>
<th>Feed Speed</th>
<th>Encoder input</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>inactive</td>
<td>inactive</td>
<td>The profile indices are used for the T axis.</td>
</tr>
<tr>
<td>inactive</td>
<td>active</td>
<td>The respective counter reading is used for the T axis.</td>
</tr>
<tr>
<td>active</td>
<td>inactive</td>
<td>For the Y axis coordinates in mm are used, whereby the coordinates are calculated from scan rate, feed speed and profile index.</td>
</tr>
<tr>
<td>active</td>
<td>active</td>
<td>For the Y axis coordinates in mm are used, whereby the coordinates are calculated from feed speed and counter reading.</td>
</tr>
</tbody>
</table>

The colored texture of the display depends on the value selected in the "Color coding" entry field. On the left side the current color scaling for the 3D-View is displayed. In the lower section the currently visible range is displayed for each axis. The 3D display offers the following interaction options:

- Rotating the point cloud: Press the left mouse button and keep the button pressed. Move the mouse to the left or right to rotate the point cloud horizontally. Move the mouse up or down to rotate the point cloud vertically. Press the <Alt> key and the left mouse button in order to activate the alternative rotate algorithm.

- Zooming in/out the point cloud: Press the <Ctrl> key and the left mouse button and keep both key and button pressed. Move the mouse upwards to zoom in the point cloud. Move the mouse downwards to zoom out the point cloud. Alternatively, you can use the mouse wheel to zoom in and out.

- Moving the range: Press the <Shift> key and the left mouse button and keep both key and button pressed. Move the mouse in the direction in which you like to move the point cloud.

Fig. 3.36: 3D-View

scanCONTROL 3D-View offers the possibility to adjust the orientation of the 3D-View for the view from the X, Y and Z direction. Press the button "View from x direction", "View from y direction" or "View from z direction" (see Fig. 3.37).

Fig. 3.37: "View from x/y/z direction" button
With the button "Reset view" (see Fig. 3.38) you can reset the orientation and the offset of the displayed point cloud (see Chapter 3.14).

*Fig. 3.38: "Reset view" button*

With the "Maximize 3D-View" and the "Restore 3D-View" button respectively (see Fig. 3.39) you can adjust the size of the 3D-View.

*Fig. 3.39: "Maximize/Restore 3D-View" button*

### 3.15 Description of the Status Display

The status display is located below the "3D mode" box. The following information is displayed:

*Fig. 3.40: "Status display" box*

- **No. of profiles [1/s]:** This display shows the effective scan rate scanCONTROL 3D-View evaluates the scanner data. The scan rate may deviate from the parameter "No. of profiles [1/s]" set in "Sensor settings", if the computer does not have sufficient processing power. The value is updated each time a complete profile sequence is received.

- **RAM total/required [MB]:** Two values are displayed. The first value indicates the size of the physical RAM of your system. The second value indicates the size of the memory currently used. If the value of the memory used exceeds that of the available memory, the system may accept user inputs only very slowly and error-free behavior is no longer guaranteed. In this case the indicated "RAM total/required" is shown in red.

- **Buffered profiles:** The number of profiles which are currently located in the measurement system buffer.

**Note:** The size of the memory used should always be smaller than the size of the available memory. Otherwise the software may accept user inputs only very slowly and error-free behavior is no longer guaranteed.
3.16  3D Visualization of a Point Cloud – Step by Step

3.16.1 In Online Mode

- Carry out the required scanner settings for the measurement system.
- In the entry field "Preview mode" select the option "continuous" to continuously update the preview window or select the option "trigger" and press the button "Trigger" to display a profile sequence in the preview window (see Fig. 3.41).

Fig. 3.41: 3D visualization – step 1
Once the required profile sequence is displayed in the preview window, press the button "Preview → 2D-View" or double click with the middle mouse button or the mouse wheel in the preview window or press <F9> to transfer the point cloud into the 2D-View.

In the 2D-View select a range of interest, if necessary (see Chapter 3.13).

Fig. 3.42: 3D visualization – step 2
Press the button "2D-View -> 3D-View" or double click with the middle mouse button or the mouse wheel in the 2D-View or press <F10> to transfer the point cloud from the 2D-View to the 3D-View. The message "Rendering 3D-View" appears in the status line. The procedure may take some seconds depending on the size of the point cloud and the system performance.

The point cloud is now displayed in the 3D-View (see Fig. 3.43).

---

**Fig. 3.43:** 3D visualization – step 3

### 3.16.2 In Offline Mode

- Choose a previously saved profile file. For this purpose, either select the "File → Open profiles" menu item or press the corresponding button (see Fig. 3.8) in the tool bar.
- The profiles are now read from the file and the preview window is updated continuously (see Fig. 3.41). Press the button "Stop" to stop the playback, if necessary.

The profile sequence is automatically transferred to the 2D-View after termination of the loading process.

- In the 2D-View select a range of interest, if necessary (see Chapter 3.13).
- Press the button "2D-View -> 3D-View" or double click with the middle mouse button or with the mouse wheel in the 2D-View or press <F10> to transfer the point cloud from the 2D-View to the 3D-View. The message "Rendering 3D-View" appears in the status line. The procedure may take some seconds depending on the size of the point cloud and the system performance.

The point cloud is now displayed in the 3D-View (see Fig. 3.43).
3.17 3D-View Settings

The "3D-View settings" dialog box offers you the possibility of configuring the settings for the 2D- and 3D-Views.

Either select the "Options → 3D-View settings" menu item or press the corresponding button (see Fig. 3.44) in the toolbar in order to access the "3D-View settings" dialog box.

Fig. 3.44: "3D-View settings" button

![3D-View settings dialog box](image)

Fig. 3.45: "3D-View settings" dialog box

The following input options are available:

- **Type**: Select the type of the coordinate system displayed in the 3D-View.
  - none: No coordinate system is displayed.
  - centered: The coordinate system is displayed centered.
  - boxed: The coordinate system is displayed around the displayed data.
- **Show labels**: Chooses whether the axis legend is to be displayed.
- **Show grid**: Select whether the grid lines are to be displayed (only with type "boxed").
- **Show reference plane**: Select whether the horizontal reference plane by which the Z coordinates are mirrored is displayed.
- **Surface**: Selects a predefined color palette for the texture in the 2D/3D-View (refer also to Fig. 5.1).
  - colors
  - grayscale (grayscale value display)
  - HSV
  - alt. colors
  - iron 1
  - iron 2
- **Adapt surface colors...**: You can vary the selected color palette and adapt it to your needs (see Fig. 3.46). The target color value will be stretched between the upper and lower limit. The color values outside the upper and lower limit will be shrunk.
  - **active**: Activate the stretching of the color palette. The automatic color scaling (2D-/3D-View) must be deactivated (see Chapter 3.8).
  - **Max**: The upper limit of the stretched target color value.
  - **Target**: The target color value is stretched between the upper and lower limit.
  - **Min**: The lower limit of the stretched target color value.

![Adapt colors dialog box](image)

**Fig. 3.46**: "Adapt colors" dialog box

- **Single surface color**: Instead of a predefined color palette, you may use a single surface color for the texture in the 3D-View.
- **Background**: Select the background color of the 3D-View.
- **Invalid values (2D-View)**: Select the color of invalid values in the 2D-View.
- **Reference plane**: Select the color of the reference plane in the 3D-View.
- **Out of range values**: Select how the values, whose Z coordinates are outside the scaling selected in the input field “z scaling (3D-View)”, should be displayed.
  - **hide**: Values are not displayed.
  - **show saturated**: Values are displayed saturated.
  - **show**: Values are displayed unchanged.
- **Show invalid values**: This parameter is used to display invalid values in the 3D-View. In this context an invalid value is designated as a point for which the scanCONTROL measurement system could not detect any reflection.
- **Profiles**: With this parameter you select the display method for the 3D-View.
  - **points**: Individual points in the point cloud are displayed.
  - **lines**: The individual profiles are shown as lines.
  - **triangles**: Surface parts are shown which are formed by triangles. The corner points of the triangles are calculated using the points in the point cloud which are located directly adjacent to one another.

![Display methods for the 3D-View](image)

**Fig. 3.47**: Display methods for the 3D-View
- **Quality**: With this parameter you determine the resolution of the 3D-View.
  - low: A maximum of 64x64 points are displayed in the 3D-View. If the number of points in the X and/or Y/T direction is larger, the number of points is reduced by average value computation.
  - normal: A maximum of 256x256 points are displayed in the 3D-View. If the number of points in the X and/or Y/T direction is larger, the number of points is reduced by average value computation.
  - high: All points are displayed in the 3D-View. Where many points are involved, this display method needs a high level of system resources.

**Note**: If the amount of used memory exceeds that of the available memory (see Chapter 3.15), the software may accept user inputs only very slowly and error-free behavior is no longer guaranteed.

- **Point size**: With this parameter you specify the size of the points which are displayed in the 3D-View. This parameter is only active in case of using the "points" option for the "Profiles" parameter.

- **OpenGL mode**: Select the OpenGL implementation that is used for displaying the 3D data.
  - OpenGL ES: The display of the 3D data is based on DirectX technology.
  - OpenGL desktop (standard): The 3D data are displayed using the vendor-specific driver of the graphics card.

**Note**: Depending on your PC configuration, it is possible that the 3D data won't be displayed. In this case change the option of the "OpenGL mode" parameter.

**Note**: When using the "OpenGL ES" mode, the labels of the axes are not available.

- **Perspective**: With this parameter you enable or disable the perspective of the 3D-View.
- **Light source**: With this parameter you define the light source:
  - no light: Virtual light is deactivated.
  - point light: When using a point light source, the light gets emitted from a single point in all directions.
  - directional light: When using a directional light source, the light propagates with parallel rays of light in one direction.
- **Light intensity [%]**: Adjust the light intensity of the virtual illumination of the 3D-View.

Confirm your settings with OK.
3.18 Resetting Parameters to the Default Settings

With this function you reset parameters of scanCONTROL 3D-View to their default settings.

Either select the "Parameters → Reset" menu item or press the corresponding button (see Fig. 3.48) in the toolbar in order to access the "Reset parameters" dialog box (see Fig. 3.49).

Fig. 3.48: "Reset" button

![Reset parameter dialog box]

Fig. 3.49: "Reset parameters" dialog box

The following parameters can be reset:

- **Sensor settings**: The parameters of the scanCONTROL measurement system (see Chapters 3.4.1, 3.4.2 and 3.6).
- **3D mode**: The parameters in the box "3D mode" (see Chapters 3.4.1).
- **Display settings**: The settings for the scaling of the 2D/3D-View (see Chapters 3.8).
- **3D data**: The settings for filtering the 3D data and calculating the trend (see Chapters 3.9).
- **Lighting/Surface**: The settings for the lighting and surface (see Chapters 3.10).
- **3D-View settings**: The 3D-View settings (see Chapters 3.17).

Press the "Check all" button in order to select all parameter types. Press the "Check all" button in order to deselect all parameter types again.

Press "OK" in order to reset the selected parameters.

3.19 Functions of the Toolbar

A summary of the functions of the toolbar (see Fig. 3.50) can be seen in the following.

Fig. 3.50: Toolbar

Selects the scanCONTROL measurement system connected to the PC as data source (see Chapter 3.4).

Selects a file in which profiles have been saved previously as data source (see Chapter 3.5).

Saves the profile sequence from the 2D-View to a file (see Chapter 4.2).

Loads parameters from a file (see Chapter 4.1.2).

Saves the current parameters to a file (see Chapter 4.1.1).

Resets parameters to default settings (see Chapter 3.18).

Shows the dialog for configuring the settings for the 3D-View (see Chapter 3.17).
3.20 "Display Image Data" View

The original signal recorded on the sensor matrix of scanCONTROL is displayed using the "Display Image Data" view. This view is useful for detecting and eliminating sources of errors and interference, such as overexposure or multiple reflections.

![Display Image Data view](image)

**Fig. 3.51: "Display Image Data" view**

**Display elements and parameters in the "Display Image Data" view:**

A  **"General" toolbar:** Using this toolbar, you can load parameters (see Chapter 3.19) and reset selected parameters to default settings (see Chapter 3.19).

B  **Sensor settings:** Change the settings of scanCONTROL with these values. Detail information about each parameter can be found in the Chapter 3.4.1 "Sensor settings". Only a part of the scanner settings is available in the "Display image data" view.

- **Video image resolution:** Change the resolution of the sensor matrix image (scanCONTROL 30X0):
  - **full:** The image of the sensor matrix is transmitted in full resolution.
  - **reduced:** The image of the sensor matrix is transmitted in reduced resolution. This setting can be used if the bandwidth of the Ethernet connection is insufficient for the full resolution.

  **Note:** In order to use the full image resolution of scanCONTROL 30X0 a gigabit Ethernet connection is required and the "Jumbo frames" option of the Ethernet interface has to be active.

C  **2D-display:** This display shows the just recorded image of the sensor matrix. The measuring field (see Chapter 3.4.2) selected with the "Measuring field" parameter is shown on the display as a red rectangle.

D  **Status line:** Status and error messages are displayed on the status line (see Chapter 5.3).

1  **Save image:** This saves the just recorded image of the sensor matrix to a file. A standard Windows dialog is displayed for selection of the path and file name for saving the image. The image is saved in "png" file format using the ".png" file extension.
2 "Display" toolbar: Using this toolbar, you scale the 2D-display and activate various options for mouse interaction:

- Activates or deactivates the "Zoom" mode. In this mode you can zoom in parts of the 2D-display and so directly set the scaling of the 2D-display with your mouse.
- Activates or deactivates the "Move profile" mode. You can move the profile on the 2D-display with an active this mode.
- Scales the 2D-display to the entire window.
- Scales the 2D-display to the original image size.

3 "Measuring" toolbar: Use the toolbar to set the measuring und reference fields with the mouse and to reset it (see Chapter 3.4.2, "Measuring field" tab).

4 Max. no. of profiles
- Measuring field [1/s]: The maximum profile frequency resulting from the setting of the "Measuring field" parameter.
- Exposure time [1/s]: The maximum profile frequency resulting from the setting of the "Exposure time" parameter.
- Sensor [1/s]: The maximum profile frequency resulting from the sensor hardware.
- Points per profile [1/s]: The maximum profile frequency resulting from the setting of the "Points per profile" parameter (scanCONTROL 30X0).
3.21 Adjusting scanCONTROL Network Settings (Ethernet Configurator)

When using a scanCONTROL measurement system with an Ethernet interface you may adjust the system network settings (IP address, etc.) by selecting the "Options → Ethernet Configurator" menu item. The "Ethernet Configurator" dialog will be opened.

**Note:** To be able to operate a scanCONTROL measurement system via Ethernet with 3D-View, the measurement system and your PC must be located in the same subnet. Adjust any relevant network settings for the measurement system in the "Ethernet Configurator" dialog.

![Ethernet Configurator dialog box](image)

**Display elements and parameters in the "Ethernet Configurator" dialog:**

1. **Device list:** This section lists all available measurement systems. Click "Scan" to refresh the list. Select the desired measurement system.

2. **Scan:** Click this button to search for scanCONTROL measurement systems in all subnets connected to the PC. The scan progress is displayed. When the scanning is complete, any found measurement systems are displayed in the list.

3. **Device info:** Displays the current settings for the selected scanCONTROL measurement system:
   - **Device:** Device name
   - **SN:** Serial number
   - **MAC address:** Physical address
   - **IP address:** IP address
   - **Subnet mask:** Subnet mask
   - **Default gateway:** Default gateway
   - **Static IP:** "Static IP" address option enabled
   - **DHCP:** "DHCP" option enabled
   - **Link local address:** "Link local address" option enabled
   - **IP configuration:** Indicates whether the network configuration is valid. If the network configuration is not valid, the measurement system cannot be used with 3D-View.
4 Desired configuration: Use the following input fields to enter the network configuration for the selected scanCONTROL measurement system:
- **IP address**: IP address
- **Subnet mask**: Subnet mask
- **Default gateway**: Default gateway
- **Static IP**: "Static IP" option – if this option is enabled, dynamic address allocation is disabled. The IP address entered is used as IP address. This parameter takes precedence over the "DHCP" and "Link local address" options.
- **DHCP**: "DHCP" option – if this option is enabled, the IP address is allocated dynamically through a DHCP server. This parameter takes precedence over "Link local address".
- **Link local address**: "Link local address" option – if this option is enabled, the IP address is allocated dynamically in the local subnet 169.254.x.x. This option is always enabled.

5 Suggest a configuration: Click this button to have a suitable configuration for the selected scanCONTROL measurement system determined automatically. After the process is complete, the system automatically completes the input fields in the "Desired configuration" section.

6 Apply to selected device: Click this button to apply the network configuration specified in the "Desired configuration" section to the selected scanCONTROL measurement system.

Proceed as follows to manually enter the network configuration parameters for a scanCONTROL measurement system:

1. When the "Ethernet Configurator" dialog is opened, the system automatically searches for available measurement systems. If the measurement system is not connected to your subnet yet, establish a connection, and click the "Scan" button. When scanning is complete, the measurement system is displayed in the device list.
2. Select the required measurement system from the device list.
3. Specify the required network settings in the input fields in the "Desired configuration" section.
4. Click "Apply to selected device" to apply the settings to the selected measurement system.
5. Click OK to confirm the selections in the "Ethernet Configurator" dialog.

Proceed as follows to automatically specify network configuration parameters for a scanCONTROL measurement system:

1. When the "Ethernet Configurator" dialog is opened, the system automatically searches for available measurement systems. If the measurement system is not connected to your subnet yet, establish a connection, and click the "Scan" button. When scanning is complete, the measurement system is displayed in the device list.
2. Select the required measurement system from the device list.
3. Click the "Suggest a configuration" button to have a suitable network configuration for the selected scanCONTROL measurement system determined automatically. After the process is complete, the system automatically completes the input fields in the "Desired configuration" section.
4. Click "Apply to selected device" to apply the settings to the selected measurement system.
5. Click OK to confirm the selections in the "Ethernet Configurator" dialog.
3.22 Documentation and Help for scanCONTROL 3D-View

You can call up various documentation and help items via the “?” menu.

![Menu with options](image)

Fig. 3.53: “?” menu

- When you select the “?” → Online help menu item or press the <F1> key, the documentation for the view currently shown will appear.
- With using the “?” → Shortcuts menu item, you obtain an overview of the available key shortcuts and mouse functions.

3.23 Exiting scanCONTROL 3D-View

- Select the “File → Exit” menu item or press the standard Windows button in the title bar of the program window in order to exit scanCONTROL 3D-View.
4. Extended Functions of scanCONTROL 3D-View

4.1 Loading and Saving Parameters

scanCONTROL 3D-View enables you to save and load parameter records. For example, you can save the parameters for various measurement objects or for different boundary conditions. You can simplify the setting up of a new object by a step-by-step adaptation.

Once you have saved the parameters for a measurement setup, you can reload them at any later point in time. You can save the parameters of any number of measurement objects.

4.1.1 Saving Parameters

In order to save the current parameters, either select the "Parameters → Save parameters to file" menu item or press the corresponding button in the toolbar (see Fig. 4.1).

![Fig. 4.1: "Save parameters to file" button](image)

A standard Windows dialog is displayed where you select the path and file name for saving the parameters. As standard, the file name has the extension ".s3d". You can use a different file extension by selecting the "All files (*)&) option in the Windows dialog in the "File type" selection field. The parameters are saved in the selected file after confirmation of the dialog.

4.1.2 Loading Parameters

In order to load previously saved parameters, either select the "Parameters → Load parameters from file" menu item or press the corresponding button in the toolbar (see Fig. 4.2).

![Fig. 4.2: "Load parameters from file" button](image)

A standard Windows dialog is displayed where you select the path and file name from which the parameters should be loaded. As standard, the file name has the extension ".s3d". You can use a different file extension by selecting the "All files (*)&) option in the Windows dialog in the "File type" selection field. The parameters are loaded after confirmation of the dialog.

Note: Use the "Recent parameters" menu item to load and apply previously saved or loaded parameters.

4.2 Saving Profiles

scanCONTROL 3D-View enables you to save the data transferred from scanCONTROL or from an offline file as a profile sequence. This file can later be loaded for offline analysis (see Chapter 3.5).

Either select the "File → Save profiles" menu item (see Fig. 4.3) or press the corresponding button in the toolbar (see Fig. 4.4) in order to save the profile sequence.

Note: The data marked in the 2D-View are used for saving profile sequences.

![Fig. 4.3: "File" menu](image)

![Fig. 4.4: "Save profiles" button](image)
A standard Windows dialog is displayed where you select the path and file name for saving the profile sequence. The profiles buffered in the 2D-View are saved in the selected file after confirmation of the dialog. This process is displayed in a status dialog (see Fig. 4.5).

**Fig. 4.5: "Saving profiles" status dialog**

### 4.3 Exporting Images

**scanCONTROL 3D-View** allows exporting data transferred from **scanCONTROL** as an image. You can import the data into image processing software later for further processing. Depending on the selected color scale (Color coding, see Chapter 3.4.1), different image formats are stored:

<table>
<thead>
<tr>
<th>Color scale</th>
<th>Image type</th>
<th>Image depth [bit]</th>
<th>Information per pixel [bit]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intensity</td>
<td>png</td>
<td>16</td>
<td>10 (upper)</td>
</tr>
<tr>
<td>Z coordinate</td>
<td>png/tiff*</td>
<td>16</td>
<td>16/32*</td>
</tr>
<tr>
<td>Width</td>
<td>png</td>
<td>16</td>
<td>10 (upper)</td>
</tr>
<tr>
<td>Threshold</td>
<td>png</td>
<td>16</td>
<td>10 (upper)</td>
</tr>
<tr>
<td>Moment 0</td>
<td>tiff</td>
<td>32</td>
<td>32</td>
</tr>
</tbody>
</table>

* When trend correction is active (see Chapter 3.9), 32 bits per pixel are used.

Proceed as follows in order to export the data transferred from **scanCONTROL** as an image:

1. Transfer the desired data to the 2D display (see Chapter 3.8)
2. Select the "File → Export 2D-View" menu item (see Fig. 4.3) in order to export the data.
3. Select the path and file name and confirm the dialog with OK.

The data will now be exported.

### 4.4 Exporting 3D Data

**scanCONTROL 3D-View** allows exporting visualized 3D data. This gives you the possibility of importing data transferred from **scanCONTROL** into 3D processing software and reprocessing the data. There are four file formats available:

- **asc:** The coordinates and textures of the point cloud are saved in columns in an ASCII file.
- **stl:** The coordinates are saved as a surface description. Two formats are available:
  - ascii
  - stl
- **csv:** The data is exported using the csv format. Three matrices are written to the csv file:
  - X coordinates
  - Y/T coordinates
  - Z coordinates
- **ply:** The coordinates, surfaces and textures of the point cloud are saved as a surface description. Two formats are available:
  - ascii
  - binary

**Note:** One of the uses of stl files in industry is to produce prototypes with stereo-lithographic machines. The stl files produced by **scanCONTROL 3D-View** are not suitable for the production of prototypes!
Extended Functions of scanCONTROL 3D-View

**Note:** The data marked in the 2D-View are used for exporting 3D data.

First select the range to be exported in the 2D-View.
Select the "File → Export 3D data" menu item (see Fig. 4.3) to export the data.

A standard Windows dialog box appears in which you can select the path and name of the file.
Select the required type in the entry field "File type" and confirm the dialog box with OK.
The data are then exported. You can watch the progress of the export task in the displayed progress dialog box.

---

**Fig. 4.6:** Selecting the data type when exporting 3D data

### 4.5 Printing

scanCONTROL 3D-View enables you to print the 3D data.

#### 4.5.1 Print Preview

Select the "File → Print preview" menu item (see Fig. 4.3) in order to display the print preview.

#### 4.5.2 Printing the Current View

You print the current 3D-View via the "File → Print" menu item (see Fig. 4.3) or with the <Ctrl + P> shortcut.

### 4.6 Selecting the Language

scanCONTROL 3D-View provides various display languages. Select the "Options → Language" menu item (see Fig. 4.7) in order to select the language.

---

**Fig. 4.7:** "Language" menu
The following languages are available:

- **English [EN]:** English.
- **Deutsch [DE]:** German.
- **簡体中文 (Chinese) [CN]:** Simplified Chinese.
- **日本語 (Japanese) [JP]:** Japanese.
- **한국어 (Korean) [KO]:** Korean.
5. Annex

5.1 Notes on Using scanCONTROL 3D-View

Please note the following when operating scanCONTROL 3D-View.

1. Never disconnect the connection between scanCONTROL and the PC while using the software. Never disconnect the power supply of scanCONTROL while the software is running.
   This may cause the software to shut down unintentionally.

2. There may be a discrepancy between the setpoint value and the actual value for the no. of scans per second if the number of scans is set too high or the processing power of the PC is insufficient.

3. The "Exposure time" parameter in the "Sensor settings" input field specifies the exposure time for the scanner. The value is also influenced by the "No. of profiles" parameter. The actual value of "No. of profiles" has priority over the "Exposure time" parameter. This results from the inequality "1/(No. of profiles) >= (Exposure time)". This means, for example, with the setting "Exposure time [ms]: 10" and "No. of profiles [1/s]: 200" the "Exposure time" value is adjusted. The new value for the "Exposure time" parameter is 5 ms.

4. The "? → Online help" menu item or <F1> key can be used for calling up help for the view currently displayed.

5. When you cannot see any profile in the preview window and no error messages are displayed in the "Status line", proceed as follows: Reset the parameters to the default settings via the "Parameters → Reset" menu item. Then valid parameters are loaded into the "Sensor settings".

6. scanCONTROL 3D-View always starts in online mode.
5.2 Key Shortcuts/Mouse Functions

Use the key shortcuts and mouse functions to work faster! There are the following possibilities:

<table>
<thead>
<tr>
<th>Mouse/key combination</th>
<th>Preview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double click of mouse wheel/middle mouse button</td>
<td>Transfers the point cloud from the preview window to the 2D-View.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mouse/key combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double click of mouse wheel/middle mouse button</td>
<td>Transfers the marked point cloud from the 2D-View to the 3D-View.</td>
</tr>
<tr>
<td>Mouse wheel</td>
<td>Zooms in/out the 2D-View.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mouse/key combination</th>
<th>2D-View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold left mouse button pressed and move mouse</td>
<td>Rotates the point cloud.</td>
</tr>
<tr>
<td>Hold Alt + left mouse button pressed and move mouse</td>
<td>Rotates the point cloud (alternative algorithm).</td>
</tr>
<tr>
<td>Hold Ctrl + left mouse button pressed and move mouse up/down or turn mouse wheel</td>
<td>Zooms in/out the point cloud.</td>
</tr>
<tr>
<td>Hold Shift + left mouse button pressed and move mouse</td>
<td>Moves the point cloud.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key shortcut</th>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Opens the online help.</td>
</tr>
<tr>
<td>F9</td>
<td>Transfers the point cloud from the preview window to the 2D-View.</td>
</tr>
<tr>
<td>F10</td>
<td>Transfers the marked point cloud from the 2D-View to the 3D-View.</td>
</tr>
<tr>
<td>Ctrl + F1</td>
<td>Changes to online mode.</td>
</tr>
<tr>
<td>Ctrl + F2</td>
<td>Changes to offline mode.</td>
</tr>
<tr>
<td>Ctrl + F3</td>
<td>Save profiles.</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Loads parameters from a file.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Saves the current parameters to a file.</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Reset parameters.</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Prints the current view.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key shortcut</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + F7</td>
<td>Settings</td>
</tr>
<tr>
<td>Ctrl + F8</td>
<td>Ethernet Configurator</td>
</tr>
</tbody>
</table>
### 5.3 Status and Error Messages

Various status and error messages are displayed in the status line of the individual views. The following messages are possible:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active: scanCONTROL <a href="%5BOption%5D">Type</a> [Version]</td>
<td>There is no fault present. scanCONTROL transfers data to the PC continuously.</td>
<td>-</td>
</tr>
<tr>
<td>Ready: scanCONTROL <a href="%5BOption%5D">Type</a> [Version]</td>
<td>There is no fault present. scanCONTROL is prepared to transfer data.</td>
<td>Press the button &quot;Trigger&quot; to start the data transfer to the PC.</td>
</tr>
<tr>
<td>Internal error</td>
<td>An unknown error has occurred.</td>
<td>Close 3D-View and reset the controller to the default settings by reconnecting the power supply.</td>
</tr>
<tr>
<td>scanCONTROL-parameters invalid</td>
<td>The parameters which have been transferred to scanCONTROL are incorrect.</td>
<td>Check the Ethernet connection and check whether the scanner is switched on and connected to a power supply. Check if the Ethernet cable is broken.</td>
</tr>
<tr>
<td>Error while data transfer</td>
<td>An error has occurred during the data transfer.</td>
<td>Check the Ethernet connection and check whether the scanner is switched on and connected to a power supply. Check if the Ethernet cable is broken.</td>
</tr>
<tr>
<td>No scanCONTROL found</td>
<td>scanCONTROL is not connected to the PC or the power supply of scanCONTROL is switched off.</td>
<td>Check the Ethernet connection and check whether the scanner is switched on and connected to a power supply. Check if the Ethernet cable is broken.</td>
</tr>
<tr>
<td>scanCONTROL S/N not found</td>
<td>scanCONTROL 3D-View was used last with a different model of scanCONTROL.</td>
<td>Open the &quot;Advanced Sensor settings&quot; dialog box and press the button &quot;Connect&quot; to select the current scanCONTROL.</td>
</tr>
<tr>
<td>No free scanCONTROL found</td>
<td>All scanners connected to the PC are already being used by other programs.</td>
<td>Close other programs accessing scanCONTROL.</td>
</tr>
<tr>
<td>scanCONTROL is already in use</td>
<td>The currently used scanner is already being used by another program.</td>
<td>Close other programs accessing scanCONTROL or press the button &quot;Connect&quot; to select another scanner.</td>
</tr>
<tr>
<td>Invalid device</td>
<td>The currently operated device is not a scanCONTROL.</td>
<td>Select a scanCONTROL device in the &quot;Advanced Sensor settings&quot; dialog and press &quot;Connect&quot; or close 3D-View and connect scanCONTROL to the PC.</td>
</tr>
<tr>
<td>Data transfer interrupted</td>
<td>The data transfer between scanCONTROL and the PC has been interrupted.</td>
<td>Check the Ethernet connection between scanCONTROL and the PC. Check if the Ethernet cable is broken. Close 3D-View, reconnect scanCONTROL to the PC and restart the software.</td>
</tr>
<tr>
<td>Inconsistent: No. of profiles too high</td>
<td>The selected value for the parameter &quot;No. of profiles&quot; is too high. Please refer to Quick Reference scanCONTROL to get more information.</td>
<td>Decrease the value for the parameter &quot;No. of profiles&quot;.</td>
</tr>
<tr>
<td>Inconsistent: Exposure time / No. of profiles</td>
<td>The selected scanner settings &quot;Exposure time&quot; and &quot;No. of profiles&quot; are mutually exclusive.</td>
<td>Type in consistent values for the parameters &quot;Exposure time&quot; and &quot;No. of profiles&quot; (see Chapter 5.1, Section 5).</td>
</tr>
<tr>
<td>Inconsistent [...]</td>
<td>The shown scanner parameters [...] are mutually exclusive.</td>
<td>Type in consistent values for the shown parameters [...]</td>
</tr>
<tr>
<td>Corrupt profile</td>
<td>The transferred profile is damaged.</td>
<td>Deactivate the filter or reset the parameters to the default settings.</td>
</tr>
<tr>
<td>No points in region of interest</td>
<td>There are no measurement points in the defined measuring field.</td>
<td>Enlarge the measuring field with the &quot;Measuring field&quot; parameter. Change the distance to the measurement object. Increase the exposure time.</td>
</tr>
<tr>
<td>No points in 3D-View</td>
<td>There are no points in the selected range for the 3D-View.</td>
<td>Select a valid range in the 2D-View and transfer the data to the 3D-View.</td>
</tr>
</tbody>
</table>
Annex

<table>
<thead>
<tr>
<th>Ready</th>
<th>The system is ready to play back a profile sequence (offline mode).</th>
<th>There is no fault present. Select a profile file and press the Play button to play back the profile sequence.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>A profile sequence is being replayed (offline mode).</td>
<td>There is no fault present. Wait until the end of the playback or abort the playback using the “Stop” button.</td>
</tr>
<tr>
<td>Couldn’t open file</td>
<td>The specified name or path was incorrect.</td>
<td>Select the correct directory containing your recorded profile sequence.</td>
</tr>
</tbody>
</table>

5.4 **Color Palettes**

The following color palettes are available for the colored texture of the 2D- and 3D- Views:

![Color Palettes]

*Fig. 5.1: Color palettes for 2D- and 3D-View*